Contents
Welcome ........................................................................................................................................ 1
Starting your Course ...................................................................................................................... 3
Programme Structure .................................................................................................................. 5
Aims and Outcomes of the Programme .......................................................................................... 6
Module Information ....................................................................................................................... 7
Coursework Presentation and Plagiarism ....................................................................................... 12
Coursework Submission ................................................................................................................. 15
Assessment Requirements for the MFA in Creative Writing Programme .................................. 17
Assessment Criteria ...................................................................................................................... 18
Degree Regulations ...................................................................................................................... 20
Student Support ........................................................................................................................... 21
Available Resources .................................................................................................................... 23
Creative Writing Staff Profiles .................................................................................................... 24
Contact Details ............................................................................................................................ 26
Appendix A: Term Dates and Deadlines ..................................................................................... 27
Appendix B: How to Format Your Fiction ..................................................................................... 28
Appendix C: Extracurricular Opportunities .................................................................................. 30
Appendix D: Getting Started with Moodle .................................................................................... 31
Appendix E: Campus Map ............................................................................................................ 32

Published August 2018
This document is for reference only. Every effort was made to ensure that information was correct at time of print, but discrepancies may still occur due to the nature of this document. Any changes will be communicated to you via email or Moodle.
Welcome
When Birkbeck College was established in 1823, its principal mission was to provide education and training to working adults who earlier in life had lacked educational opportunity. A College of the University of London since 1920, Birkbeck is committed to the concept of lifelong education, and especially within the world of work. Birkbeck and the other member colleges of the University of London have many research interests in common and share the same standards and degrees structures, but in one important respect Birkbeck is unique. Our mission is ‘to provide courses of study to meet the changing educational, cultural and training needs of adults who are engaged in earning their livelihood, and others who are able to benefit’ (Birkbeck College Charter).

Birkbeck College has built up special expertise in providing a stimulating, positive learning environment for adult, mature students. Recently we have also expanded our provision for full-time postgraduate students. We award undergraduate degrees in a full range of disciplines and have an unusually high proportion of students following taught Masters and MPhil/PhD courses.

The MFA in Creative Writing is offered by the Department of English and Humanities in the School of Arts and can be taken full-time for one year or part-time over two-years. All classes are taught in the evenings.

Students will benefit from the expertise of writers with international standing, as well as visiting publishers, editors and literary agents. Students can also volunteer as editors for the annual literary magazine, The Mechanics’ Institute Review that showcases student writing and facilitates contact between students and the creative industries and as interns on the MIROnline website and the MIRLive events which take place termly. Further information about these activities can be found at www.mironline.org and by signing up for the newsletter.

Students begin the programme in the autumn term with the Advanced Writing Workshop. Each weekly class is a chance for students to present and discuss the project upon which they are focussing.

In the spring term, the Reading and Writing the Contemporary Seminar will involve presentations by academics from within the School of Arts. These will focus on setting recent creative works within a critical framework.

In the summer term there will be a series of lectures and craft seminars focusing on aspects of narrative art, and Q&As with visiting speakers (such as a literary agent and an editor from a publishing house). These seminars and talks give crucial insights into the mechanisms of the novel and the cultural industries respectively and are not to be missed. The summer term is a non-assessed term.

Your Dissertation Supervisions will occur throughout the spring and summer terms, by appointment with your tutor. Full time students will get four one-hour supervisions. Part time students will have two one-hour supervisions.

During the autumn term, you will be assigned a Personal Tutor who will be your first contact for any queries you may have about academic or pastoral issues.
Birkbeck is now a corporate member of the Royal Society of Literature. More information can be found on their website at www.rslit.org.
Starting your Course

Enrolment: Important Information
After receiving an offer of a place on the MFA, you need to enrol as soon as possible (see administrative information, below). For early applicants this option is usually available from July onwards. Late applicants (those interviewed in August/September) may experience some delay in receiving their enrolment details at what is the busiest time of the year for Registry. Please click here to complete your enrolment via your My Birkbeck profile.

The College will expect you to have formally enrolled and to have begun paying your fees by mid-October. You must enrol by the end of October or you may not be eligible to continue your degree.

A student who withdraws after enrolling is liable for payment of fees for the first term of their intended study, and all subsequent terms up to and including the term in which they withdraw or for the full fees due for all modular enrolments (whichever is greater). Fees are not returnable, but requests for ex-gratia refunds of part of the fees paid in cases where a student is obliged to withdraw because of circumstances beyond the student's own control (but normally excluding changes in employment) may be made.

Fees/ Finance
College fees may be paid by many methods. Additional expenses will be incurred and it is important to budget for the purchase of books. Whilst we have great sympathy with students who find difficulties in paying their fees, neither the Course Director nor any of your supervisors have the power to waive fees or sanction delays in payment. The College Income Office deals with fees and you should communicate and negotiate with them directly on 0203 907 0700. Students who fail to pay their fees may become ineligible to continue the course or unable to submit assessments. Any student who has a debt to the College at the end of the year will not have their marks relayed to them. The College fees policy can be found here www.bbk.ac.uk/mybirkbeck/services/rules/College-Fees-Policy.pdf

Contact Details/Email
Birkbeck students are required to maintain their personal details via the My Birkbeck Profile (student intranet) throughout their period of study. Failure to maintain this information via your student portal will mean that you may miss important information concerning the course. You may nominate an email via your My Birkbeck Profile. If you encounter any difficulty with this process please visit the ITS Service Desk in the main Malet Street building. Email is the normal means of communication in the School of Arts.

Location
The School of Arts is housed at 43 Gordon Square, London WC1H 0PD, where you will find the administrative offices and individual staff offices. Teaching often takes place in our building, but your lectures may be held in any of the University of London or University College London buildings. Please login to your My Birkbeck Profile for access to your student timetable and links to maps of the buildings.

The Administrative Office
Please contact your Programme Administrator by phone or email to discuss any queries or to book an appointment. During term time, the Gordon Square entrance is staffed from 8.00am to 9.00pm, Monday to Friday and is open between 9.00am and 5.00pm on Saturdays.
Please access the student pigeonholes (located outside room G13) and deliver hardcopy coursework to the essay box by reception, during these times.

**Moodle (Birkbeck’s Virtual Learning Environment Platform)**

**Moodle** is an online student portal. You will be expected to upload and submit all assignment documents using Moodle throughout the duration of your study. You can also use Moodle to access interactive tutorials, lecture slides, reading lists and recorded lectures, career management resources and your personal student record.

It is recommended all students access Moodle Support for Students to become familiar with how to access Moodle and submit coursework online. Please Login to Moodle with your Birkbeck College username and password. If you do not have your username and password, please contact ITS Reception in the main Malet Street building or by e-mail at its-helpdesk@bbk.ac.uk. If you have difficulty using Moodle, please contact/visit the ITS Help Desk where they can walk you through the process.

**Books: to buy or borrow?**

Throughout your MFA you will be given reading lists, which will include both essential texts forming the basis of lectures and seminars, and suggestions for wider reading. The distinction between these two categories is clearly marked in this booklet. The first you will normally be expected to buy (particular versions or editions are specified in some cases) or photocopy from the short loan collection in Birkbeck Library. If you have trouble obtaining the recommended edition, or already own an alternative, a substitute will often be acceptable; consult the lecturer concerned if you are in any doubt. If you intend to rely on libraries, bear in mind that many other students will inevitably need the books at exactly the same time as you do. It is your responsibility to obtain these books in time for the classes. If you do find that a book has become unobtainable for any reason, please let the lecturer know as soon as possible.

**Attendance Requirements**

Taking a degree course at Birkbeck requires a high level of commitment, and it is important that you attend seminars consistently. Regular attendance is a requirement of every course unit and you will be required to register your attendance each week. **It is your responsibility to make sure you sign in using the e-register (see below) at every class you attend.** It is accepted that through illness or exceptional pressure at home or at work you may have to miss occasional classes, but if you have to be absent from several classes, or you know that you are going to have difficulties in attending regularly, please inform the Programme Director. **We do require notice of intended absence in writing (by email) to your module tutor AND your Programme Administrator.**

**Registering your attendance with eRegisters**

The eRegisters system allows students to keep track of and monitor their own attendance at teaching events. In Birkbeck teaching rooms, students will be expected to tap their Birkbeck student ID card onto a card reader at the beginning of each class. **Please remember it is your responsibility to bring your Birkbeck ID card to class to monitor your attendance. This is especially important for those of you that are Tier 4 students.** For further information on eRegisters please click here.
# Programme Structure

## Part-Time

<table>
<thead>
<tr>
<th>Part-time students Year 1</th>
<th>Term 1</th>
<th>Term 2</th>
<th>Term 3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Advanced fiction workshop</td>
<td>Reading and Writing the Contemporary</td>
<td>Craft Lecture Series</td>
</tr>
<tr>
<td></td>
<td>Tuesday</td>
<td>Various days</td>
<td>Tuesday</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part-time students Year 2</th>
<th>Term 1</th>
<th>Term 2</th>
<th>Term 3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Dissertation Supervision</td>
<td>Dissertation Supervision</td>
<td>Craft Lecture Series</td>
</tr>
<tr>
<td></td>
<td>Tuesday</td>
<td>Various days</td>
<td></td>
</tr>
</tbody>
</table>

## Full-time

<table>
<thead>
<tr>
<th>Term 1</th>
<th>Term 2</th>
<th>Term 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced fiction workshop</td>
<td>Reading and Writing the Contemporary</td>
<td>Craft Lecture Series</td>
</tr>
<tr>
<td>Tuesday</td>
<td>Various days</td>
<td>Tuesday</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Term 2</th>
<th>Term 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dissertation Supervision</td>
<td>Dissertation Supervision</td>
<td>Dissertation Supervision</td>
</tr>
</tbody>
</table>
Aims and Outcomes of the Programme

The aims of the programme are to:

- Enable students to develop their skills as writers of fiction
- Deepen students’ awareness of form and elements of the writer’s craft
- Provide students with opportunities to interact regularly with fellow writers
- Develop students’ skills of self-evaluation and constructive analysis of the work of others
- Enable students to develop skills in editing and revising their own writing.
- Develop students’ awareness of the industry-standard expectations for their creative work
- Broaden students’ knowledge and critical judgment of the histories, conventions, and processes of fiction
- Place their own writing in the context of developments in contemporary fiction
- Encourage students to investigate fiction from a diverse range of cultures and how these works might inform and inspire their own writing
- Gain a greater practical knowledge and understanding of the markets for fiction

By the end of the programme students will have:

- Developed the skills and techniques involved in writing in a particular genre
- Developed a critical understanding of literary writing through study of contemporary movements and theory, close readings of individual texts and by placing your own work in relation to contemporary writers
- Gained practical knowledge of the publishing industry by learning how to present and market your creative work
- Completed and submitted for assessment a creative writing portfolio of high literary quality

Module Availability

We reserve the right to cancel modules that do not recruit the minimum student numbers as required by Birkbeck College. In addition, please remember that both the requirements of the Department and the personal circumstances of tutors may change over the course of the year. This booklet is for reference only.
Module Information

Autumn Term

The autumn term starts on Monday 1 October with an induction for all new students on Thursday 27 September. This is an opportunity for you to meet tutors and fellow students and to learn more about the programme. Details of the induction will be sent to students via email closer to the date.

The first Advanced Fiction Workshop will run on Tuesday 2 October.

Advanced Fiction Workshop
AREN24S7
Tuesday
6:00pm-8.30pm
Tutor: Toby Litt

Module Aims and Outcomes
• Develop confidence, sensitivity and discernment in their analysis of their own and their fellow students' work
• Develop to a professional level the craft of writing in their chosen genre
• Achieve a greater critical understanding of contemporary literary developments
• Place their own writing in the context of developments in contemporary fiction
• Develop to professional level skill in editing of both their own and fellow students' creative work
• Gain a greater practical knowledge and understanding of the markets for fiction

Module Description
This module focuses on the student’s emerging creative writing. Each of the ten sessions is devoted to students presenting work for the class to critique (These excerpts should be no longer than 5000 words in length but can be shorter).

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coursework</td>
<td>5000 words</td>
<td>100%</td>
</tr>
</tbody>
</table>

Required Texts
Any required reading will be made available at the start of term (via Moodle). It is your responsibility to read set texts in advance of class each week.

Coursework Deadline
Monday 14 January 2019, 2pm via Turnitin

Recommended Reading
Bennett, Claire-Louise, Pond (Fitzcarraldo Editions, 2015)
Langley, R.F., Journals (Shearsman, 2006)
Williams, Eley, Attrib (Influx, 2017)
Further Reading
Coates, Ta-Nehisi, *Between the World and Me* (Text, 2015)
Foster Wallace, David, *Both Flesh and Not* (Penguin, 2013)
O’Connor, Flannery, *Mystery and Manners* (Faber, 1984)

Websites
Thresholds Short Story Forum: [http://blogs.chi.ac.uk/shortstoryforum/](http://blogs.chi.ac.uk/shortstoryforum/)
Paris Review: [http://www.the parisreview.org/](http://www.the parisreview.org/)
New Yorker Fiction Podcasts: [http://www.newyorker.com/online/blogs/books/podcast/](http://www.newyorker.com/online/blogs/books/podcast/)
Word Factory Video Archive: [http://www.thewordfactory.tv/site/](http://www.thewordfactory.tv/site/)
Spring Term

The Spring term begins on Monday 14 January 2019. Full and part-time first year students take one option course (Creative Writing option details follow here and online). Full-time and second year part-time students also take the Writing Workshop.

Reading and Writing the Contemporary
AREN223S7
Wednesday
6:00-8.00pm
Tutors: Toby Litt

Module Outcomes and Aims
- Develop a greater critical understanding of contemporary literary developments
- Place their own writing in the context of developments in contemporary fiction
- Gain a greater practical knowledge and understanding of the markets for fiction

Module Descriptions
This seminar will be lead each week by a different member of staff, both Creative Writing lecturers and academics in Modern and Contemporary Literature from the department of English and Humanities. The aim is for students to develop a more complex critical and aesthetic awareness of literary qualities and techniques from a range of genres and to gain a sense of inclusivity in a world class research centre at Birkbeck.

Essential Reading
The text for each week.

Week One
Peter Fifield on Rings of Saturn (Vintage 2013) by WG Sebald

Week Two
Anna Hartnell on Sing, Unburied, Sing (Bloomsbury 2018) by Jesmyn Ward

Week Three
Grace Halden on Of Love and Other Monsters by Vandana Singh (Aqueduct Press 2007)

Week Four
Julia Bell on Reading and Writing the Contemporary

Week Five
Reading Week

Week Six
Steve Willey on Citizen: An American Lyric (Penguin 2015) by Claudia Rankine

Week Seven
Marina Warner on Seiobo There Below (Tuskar Rock 2008) by Laszlo Krasznakorkai

Week Eight
Katherine Angel on Mixed-Race Superman by Will Harris (Peninsula 2018)

Week Nine
Roger Luckhurst on Annihilation (Fourth Estate 2014) by Jeff VanderMeer
**Week Ten**
Richard Hamblyn on *Cyclogeography: Journeys of a London Bicycle Courier* by Jon Day (Notting Hill Editions 2015)

**Week Eleven**
Julia Bell to lead seminar on essay writing

The exact order of the sessions is subject to change.

**Coursework and Assessment**

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Essay</td>
<td>5000 words</td>
<td>100%</td>
</tr>
</tbody>
</table>

**Coursework Deadline**
Monday 29 April 2019, 2pm via Turnitin
Summer Term

The summer term is a non-assessed term, however attendance at the lectures and craft seminars is strongly encouraged. You will receive dissertation supervision and there will be a ten-week series of lectures and craft seminars focusing on aspects of narrative design, together with talks from visiting speakers. Previous speakers have included prizewinning authors, literary agents, book publishers and specialists on e-publishing.

MFA in Creative Writing Dissertation
AREN222Q7
By appointment

Module Aims and Outcomes
- Develop to a professional level the craft of writing
- Develop a greater critical understanding of contemporary literary developments
- Place their own writing in the context of developments in contemporary fiction
- Develop to professional level skill in editing of their own creative work
- Gain a greater practical knowledge and understanding of the markets for fiction

Module Description
Students work with their supervisors on the dissertation in one-to-one tutorials. Students are expected to make appointments with tutors through the online diary, Doodle.

You will be expected to produce extracts of around 3,500 words for each tutorial. Your supervisor will need you to send this work to them by email attachment no later than ONE WEEK before the date of the supervision. You will get oral feedback from tutors, with some annotation on the scripts themselves.

The focus of these tutorials will be developmental, with a close focus on your prose and ideas. To a large extent, the overall course of the tutorials will be down to you. If you feel there are areas you wish to cover, please bring this up with your tutor.

The Dissertation is normally submitted by mid-September. If submitting a novel extract or work of creative non-fiction, you may include a brief synopsis, if necessary, that does not have to be included in the word count.

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dissertation</td>
<td>40,000 words</td>
<td>100%</td>
</tr>
</tbody>
</table>

Coursework Deadline
Monday 9 September 2019, 2pm via Turnitin

Please note: to remove the possibility of students duplicating work previously submitted for assessment, all dissertation material must not have been previously assessed either within Birkbeck or at another academic institution.
Coursework Presentation and Plagiarism

Guidelines and Style sheet

References within your essay and the bibliography should be full, consistent and properly presented. **You are expected to consult and follow the MHRA Style Book** where a much fuller discussion of presentation is to be found. It can be downloaded from the Department of English and Humanities website: [http://www.mhra.org.uk/Publications/Books/StyleGuide/download.shtml](http://www.mhra.org.uk/Publications/Books/StyleGuide/download.shtml).

Essays for options run by departments other than English and Humanities should, however, follow their documentation guidelines.

While minor lapses (e.g. commas out of place, forgetting to mention the translator of a work in the bibliography) may be ignored if they are infrequent, you will be penalized for sloppy and inaccurate documentation. While doing your preparatory reading, it is important to take full and accurate references so as to avoid spending a great deal of time hunting back through works to find page numbers etc.

Often MFA students underestimate the time it takes to prepare a successful essay. This is not only because of the extent of the reading required, but because constructing a carefully-documented piece, and dealing with a larger body of primary and secondary materials than you are likely to have experienced in writing undergraduate essays, is a time-consuming process. No matter how long you spend on doing the preparatory reading, leave yourself plenty of time to write your piece.

**Presentation**

**Editions**
Wherever possible, standard editions should be used, especially for passages essential to the argument of the essay. References to the same work should be to the same edition, unless differences between editions are relevant to the argument of the essay.

**Quotations**
Quotations must be accurate and should be checked carefully before the essay is submitted.

Prose quotations up to about three lines and verse quotations up to one full line should be incorporated into the body of the text. Longer quotations should be inset, in which case inverted commas are not needed.

Once the source of quotation has been clearly identified in a footnote, quotations from the same text and edition can be identified by page number (or line number, or act, scene and line number etc., as appropriate) in parentheses immediately after the quotations, thus avoiding unnecessary footnotes.

**Footnotes**
Footnotes should be succinct; they should not become miniature essays. There are good grounds for restricting footnotes to:

i) The identification of quotations and other essential documentation.

ii) Undeveloped references to other relevant material: ‘see also…’
Documenting footnotes should follow the sequences:

a) Printed books: author, title (underlined); editor’s name (if appropriate, preceded by ‘ed.’); place and date of publication (in parentheses); volume and/or page number(s).

b) Periodical articles: author, title of article (within single inverted commas); title of periodical (underlined); volume number; date of publication (in parentheses); page number(s).

Sample footnotes:
(2) Hibbard, pp. 25-6 [a following reference to the same book]
(4) Lois Whitney, ‘English primitavistic theories of epic origins’, MP, 21 (1924), 337 or MP, xxi (1924), 337

List of Sources
At the end of the essay should be listed all the works, including editions of the texts discussed, that have been consulted in its preparation. The list should be in alphabetical order of author. The conventional sequences are as follows:

- **printed books**: author (surname first), title (underlined); editor (if appropriate); number of volumes (if more than one); place of publication [colon] publisher [comma] year of publication
- **articles**: author (surname first); title in single inverted commas; title of periodical (underlined); volume number; date (in parentheses); numbers of first and last pages of article.

Acknowledgements
In footnotes and list of sources the student must make clear acknowledgement of ALL works, reports and sources from the internet used in writing the essay and should not descend to plagiarism or collusion. S/he should carefully note the University of London General Regulations for Internal Students, 9.5:

> Where the regulations for any qualification provide for part of an examination to consist of ‘take-away’ papers, essays or other work written in a candidate’s own time, course-work assessment or any similar form of text, the work submitted by the candidate must be his own, and any quotation from the published or unpublished works of other persons must be duly acknowledged.

> Plagiarism is the quotation, verbatim or virtually verbatim, of other people’s work, published or unpublished, without acknowledgement. Plagiarism carries severe penalties and may even warrant exclusion from the course. If in doubt about the protocols of acknowledgement, ask.

Assessment
All assessed essays are double-marked; a set of comments and a mark are returned to the student. These marks remain provisional until ratified by the external examiner at the Board of Examiners’ meeting in November of the following year.
**Student Support**
Any matters that students want to discuss that are directly related to the content of the MA should be discussed with the appropriate tutor. Staff telephone numbers and email addresses have been provided under contacts.

**Plagiarism**
Plagiarism, the act of taking somebody else's work and presenting it as your own, is an act of academic dishonesty, and Birkbeck takes it very seriously.

Examples of plagiarism include (but are not restricted to):
- copying the whole or substantial parts of a paper from a source text (e.g. a web site, journal article, book or encyclopaedia), without proper acknowledgement
- paraphrasing another's piece of work closely, with minor changes but with the essential meaning, form and/or progression of ideas maintained
- piecing together sections of the work of others into a new whole
- procuring a paper from a company or essay bank (including Internet sites)
- submitting another student's work, with or without that student's knowledge
- submitting a paper written by someone else (e.g. a peer or relative) and passing it off as one's own
- representing a piece of joint or group work as one's own.

If you knowingly assist another student to plagiarise (for example, by willingly giving them your own work to copy from), you are committing an examination offence.

**What happens if plagiarism is suspected?**
In October 2008, the College introduced a new three stage policy for dealing with assessment offences. The first stage allows for a very rapid and local determination for first or minor and uncontested offences. Stage two allows for a formal Department investigation, where a student wishes to contest the allegation or penalty, where there is an allegation of a repeat offence or for more serious cases. Stage three involves a centrally convened panel for third and serious offences, dealt with under the code of Student Discipline.

**What if I am worried that I'm not referencing correctly?**
Please see your module tutor or contact a member of the learning support team as soon as possible. Ignorance to Birkbeck’s commitment to student standards will not be accepted as an excuse in a plagiarism hearing. The following links from Birkbeck’s Registry provide some helpful information, but are not intended to replace any guidelines or tuition provided by the academic staff.

**General Guidelines**
http://www.bbk.ac.uk/student-services/exams/plagiarism-guidelines

**Assessment Offences Policy**

**Plagiarism FAQ**
Coursework Submission

All work should normally be computer-generated (using a format compatible with Microsoft Word, and not a PDF or similar). All work should be submitted double-spaced. Please note that the word count should include footnotes but excludes the bibliography.

Your work should normally be submitted electronically, via Turnitin (or, exceptionally, in case of difficulty with this system, by email to the administrator concerned). You may, exceptionally, also be asked to leave a paper copy in the coursework box in the entrance hall of 43 Gordon Square. You should also retain a copy yourself. **In no circumstances should essays be handed directly to the lecturer or seminar leader.**

For further information and instructions on how to submit coursework using Turnitin please see the appendices or visit the ITS Help Desk.

Return of Coursework
Coursework will **normally** be marked and returned electronically within 4-6 weeks from the stated submission date or the date of handing in, whichever is later. Larger modules and modules with numerous seminar groups, such as core modules, could take longer due to the number of students involved. There may also be a delay if the college is closed or if there are extended holidays during that 4-6 week period.

**Your administrator will email you to let you know when coursework has been marked. Please do not phone/e-mail to ask whether your essay has been marked unless the marking periods as above have elapsed.**

College Policy on Marking and Moderation
It may also be useful to familiarise yourself with the official college assessment policy. Please see the following link: [http://www.bbk.ac.uk/registry/policies/documents/college-policy-on-marking-and-moderation.pdf](http://www.bbk.ac.uk/registry/policies/documents/college-policy-on-marking-and-moderation.pdf)

Late Submission of work for assessment
All Schools and Departments across the College have moved to a system whereby students are **not** permitted to ask for extensions to coursework deadlines. If for some reason you are unable to submit a piece of work by the deadline, you should complete a Mitigating Circumstances form, which can be downloaded from the Birkbeck website [here](http://www.bbk.ac.uk/registry/policies/documents/college-policy-on-marking-and-moderation.pdf). This form gives you space to describe the circumstances that have prevented you from meeting the deadline, and requires you to provide supporting evidence (e.g. medical certificate).

It is advisable to discuss the situation with your personal tutor before submitting the form. The **Mitigating Circumstances Form** should be emailed to the course administrator or handed in to the Department office **within 7 days of the deadline**. Any work that is submitted for formal assessment after the published deadline is given two marks: a penalty mark of 50% for postgraduate students, assuming it is of a pass standard, and the ‘real’ mark that would have been awarded if the work had not been late. The case will then be considered by the appropriate sub-board or delegated panel.

If no case is made then the penalty mark will stand. If a case is made and accepted then the examination board may allow the ‘real’ mark to stand.
**Note:** If you are taking an option within another School please note that you will need to adhere to the deadline/extension policy of the School in which the option course is based.

**Dissertations**

It is particularly important to submit dissertations on the deadline date. This deadline is not negotiable. If missed, the candidate may not be examined in the same year and may have to wait another twelve months before being awarded the degree as MFA examination boards meet only once a year, in November. Any difficulty in meeting the dissertation deadline should be brought to the attention of the Course Director at the earliest opportunity.
Assessment Requirements for the MFA in Creative Writing Programme

Assessment is based entirely on coursework. To pass the programme, students must complete all the coursework, plus the dissertation, and achieve an overall mark of 50 or above. The dissertation should take the form of a collection of short stories, a novella, part of a novel, or a work of creative non-fiction. Coursework should normally be submitted in the first week of the succeeding term. All manuscripts must be typed in Times New Roman and double-spaced.

Students who fail their dissertation are allowed to resubmit once.

Assessment Weighting

- 20% Advanced fiction workshop. Credits for attendance
- 20% Reading & Writing the Contemporary. Essay, (5,000 words in total)
- 60% Dissertation (40,000 words in total – not including bibliography)

Marking Scheme

**Distinction**
A 75% - 100%
A - 73% - 74%
A -- 70% - 72%

**Merit**
AB 69%
B++ 66% - 68%
B+ 63% - 65%
B(+) 60% - 62%

**Pass**
B 59%
B(-) 56% - 58%
B- 53% - 55%
B-- 50% - 52%

Moderation and Marking

All coursework is subject to a rigorous moderation procedure. It is first-marked, and then second marked, whereby lecturers ensure that marking has been consistent, for the module. A further sample of module marks are also reviewed by the external examiner. There is no process whereby students can request a piece of work be “remarked” on academic grounds; the academic judgment of the first and second marker and the fairness of grades is reviewed by the externals, as part of the moderation process and Sub-Board of Examiners procedure.
Assessment Criteria

Short Creative Pieces

A Pass should show:
- Engagement with the structure and conventions of a particular genre
- Understanding of the relationship between content and form
- Competent use of language
- Awareness of reader/audience

A Merit should also show:
- Confident handling of the structure of a particular genre
- Willingness to experiment
- Fresh (i.e. non-clichéd) use of language

A Distinction should also show:
- Ambitious and/or original choice of content
- Accomplished handling of chosen form
- Original use of language

Critical essays on contemporary writing

A Pass should show:
- Awareness of the variety and range of contemporary writing
- Ability to analyse the use of language in published writing
- Analysis of the relevant aspects of the 'craft' of writing
- Sustained critical thinking
- Competent use of language

A Merit should also show:
- A willingness to approach 'difficult' writing
- Ability to sustain a convincing critical analysis
- Fresh use of language

A Distinction should also show:
- Sharp critical insight into what makes a literary work successful against different criteria
- Awareness of critical methods and theories
- Fluent use of critical language

Dissertation

A Pass should show:
- Awareness of the strengths and limitations of the chosen genre and of its 'fitness for purpose'
- Ability to use structure and voice to develop elements of one or more of the following: narrative, theme, character, prosody
- Understanding of the relationship between content and form
- Competent use of fictional, dramatic or poetic techniques
- Awareness of reader/audience
- Commitment to editing
- Appropriate use of research (where relevant)

A Merit should also show:
- Ambition in both formal and thematic or narrative scope of the piece
- Development of distinctive writing 'voice'
- Ability to produce fresh (i.e. non-clichéd) passages of writing

A Distinction should also show:
- Ability to produce a fully realised, sustained piece of writing
- Originality of use of one or more of the following: language, form, content
Degree Regulations

Undergraduate and Postgraduate Study

The majority of Birkbeck’s programmes are offered as part of the College’s Common Award Scheme (CAS). Programmes will therefore have common regulations, and a common structure. This will help to ensure greater consistency of practice amongst programmes and will also make it possible for you to take modules from Departments across the College which are outside of your normal programme (subject to programme regulations and timetable constraints).

Some areas covered by CAS Regulations include:
- Degree Structure
- Degree Classification
- Module Weighting
- Marking Scheme
- Failure and Re-Assessment
- Plagiarism and Academic Offences
- Mitigating Circumstances.

You are strongly encouraged to read the information provided here http://www.bbk.ac.uk/registry/policies/documents/CAS-reg-18-19.pdf.

Research Ethics

All research involving human participants and confidential materials, carried out by students in the School of Arts is subject to an ethics approval process. This is to ensure that the rights of participants and researchers alike are protected at all times, and to underline our commitment to excellence in research across a wide range of subjects.

If you are undertaking any such research work for a dissertation, project, thesis etc. please complete the form ‘Proposal for Ethical Review template’ and pass this to your academic supervisor. The proposal will be reviewed and assessed as ‘routine’ or ‘non-routine’. In most cases it is envisaged that such work will be routine, and your supervisor will inform you of the outcome. In a small number of cases, the proposal may be referred to the School’s Ethics Committee for further consideration. Again, you will be informed of any outcome.

The proposal form is available through our departmental web pages (current students). If you have any queries, please speak to your supervisor in the first instance.

Further guidelines are available on the MyBirkbeck website at http://www.bbk.ac.uk/mybirkbeck/services/facilities/support/research-ethics.

Please Note
We do not undertake anonymous marking taking the view that it is unenforceable and unworkable as the small team of tutors develop a good knowledge of student work. This falls under the ‘practical work’ exception of Section 10 of the College assessment policy.
Student Support

Student Services at Birkbeck encompass a wide range of services within Birkbeck, aimed at supporting students’ learning experience and personal development.

Advice Service
Our trained advisors are on hand to provide information and advice about many aspects of your studies at Birkbeck including but not limited to: application and enrolment process, applying for government loans and financial support from the College, and payment options.

Where we cannot answer questions immediately, we will either get back to you with an answer or refer your query to a specialist team who can.

Ask us a question, call us on 020 3907 0700 or come along to our drop-in sessions for help and support. Alternatively, please visit our website for further information.

Careers and Employability Service
We provide comprehensive careers advice, events and information services both in person and online. The service is free and available to all Birkbeck students and recent graduates.

To find out how we can help you to enhance your career development and employability ask us a question or visit the Students’ Employability Space. Alternatively, please visit our website for further information.

Counselling Service
We offer a free, non-judgmental and confidential counselling service to support you with emotional or psychological difficulties during your time at university.

To make an appointment for an initial consultation, please email counselling-services@bbk.ac.uk with your name, student ID, gender and telephone number. Alternatively, please visit our website for information about the service including a comprehensive selection of self-help resources which may be useful in gaining a greater understanding of the personal challenges you are facing and the ways in which you can think about addressing them.

Disability and Dyslexia Service
At Birkbeck we welcome students with disabilities and we are committed to helping you seize the opportunities that studying here presents. Regardless of your condition, our experienced, understanding and welcoming staff are here to support you during your studies.

To make an appointment, please contact the Wellbeing Team from your My Birkbeck profile by clicking on ‘Ask us’ and selecting ‘New Ask’ or call us on 020 3907 0700. Alternatively, please visit our website for information about a Study Support Plan, Disabled Students’ Allowance, free dyslexia screening and more.

Study Skills
Through a range of workshops, accessible learning materials, and one-to-one meetings, our Learning Development Service is here to help you to fulfil your potential in a number of
ways while studying at Birkbeck. Visit our Learning Skills module on Moodle for resources that will help you build academic skills and increase academic performance. Ask us a question, call us on 020 3907 0700 or visit our website for advice and support with study skills.

**Mental Health Advisory Service**
We provide specialist advice and support in a safe, non-judgemental environment. Like the Counselling Service, we are here to help you when you are going through emotional or psychological difficulties. The main difference between our services is that the emphasis of our work is on practical support, rather than therapeutic interventions, to enable you to progress through your studies.

To make an appointment, please contact the Wellbeing Team from your My Birkbeck profile by clicking on 'Ask us' and selecting 'New Ask' or call us on 020 3907 0700. For further information about the service, please visit our website.

**Nursery Service**
We understand that studying while caring for a child or children can be especially challenging and so we offer an affordable, professional evening nursery service, based in our central London campus, for children aged from two to six years.

For further information and contact details, please visit our website.
Available Resources

The MyBirkbeck student portal [http://www.bbk.ac.uk/mybirkbeck/] holds lots of information that you will find useful during your programme of study, as well as your own student profile (for your contact details, timetable and module results). Some important pages are listed here:

<table>
<thead>
<tr>
<th><strong>Disability &amp; dyslexia support</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.bbk.ac.uk/mybirkbeck/services/facilities/disability">http://www.bbk.ac.uk/mybirkbeck/services/facilities/disability</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Computing &amp; IT support:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.bbk.ac.uk/mybirkbeck/services/facilities/computing">http://www.bbk.ac.uk/mybirkbeck/services/facilities/computing</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Birkbeck Library</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.bbk.ac.uk/lib/">http://www.bbk.ac.uk/lib/</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Senate House Library</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.bbk.ac.uk/lib/otherlibs/shl">http://www.bbk.ac.uk/lib/otherlibs/shl</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Student support</strong> (includes learning support, nursery, careers, accommodation and Students union info)</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.bbk.ac.uk/mybirkbeck/services/facilities">http://www.bbk.ac.uk/mybirkbeck/services/facilities</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Fees and financial support</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.bbk.ac.uk/mybirkbeck/finance">http://www.bbk.ac.uk/mybirkbeck/finance</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Rules and regulations relating to your MFA</strong> (including the Common Award Scheme)</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.bbk.ac.uk/mybirkbeck/services/rules">http://www.bbk.ac.uk/mybirkbeck/services/rules</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Late work and mitigating circumstances</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.bbk.ac.uk/mybirkbeck/services/administration/assessment/coursework/mitigating-circumstances">http://www.bbk.ac.uk/mybirkbeck/services/administration/assessment/coursework/mitigating-circumstances</a></td>
</tr>
</tbody>
</table>

**Support**

Each student is assigned a personal tutor. For advice and information you can turn to this personal tutor, to the lecturers teaching you, to your Programme Director whom you may contact by e-mail or phone. Any matters concerning the course should be taken up with the course director. You may discuss medical problems in strict confidence. You are strongly advised to maintain regular contact with your personal tutor.

You may also take up issues with the Student Union. You become a member of the Union automatically as a registered Birkbeck student. Information on the services they offer are available on their website: [www.bbk.ac.uk/su](http://www.bbk.ac.uk/su) or phone 020 7631 6335.

**Representation**

Each year, we ask for two or more students from the MFA to represent your concerns to programme tutors. These representatives collate student feedback to present at a termly ‘staff/student forum’ meeting, where issues specific to your experience as a student on the MFA in Creative Writing are discussed.
Creative Writing Staff Profiles

TOBY LITT
Reader in Creative Writing | MFA Course Director | Novelist | Critic
Toby Litt is the author of eight novels and four short story collections. His most recent book is Wrestliana, an exploration of his relationship to his great-great-great grandfather, William Litt, who was a champion wrestler, poet, novelist, and smuggler (Galley Beggar, 2018). He has also written comics including the Dead Boy Detectives monthly series and, in collaboration with Neil Gaiman, Free Country: A Tale of Children’s Crusade (Vertigo, 2015). Toby was chosen as one of Granta’s Best of Young British Novelists in 2003. Along with Ali Smith, he edited the New Writing 13 anthology. He reviews for The Guardian, and appears regularly on Radio 3’s The Verb. He is a member of English PEN. His website is at www.tobylitt.com.

JULIA BELL
Senior Lecturer in Creative Writing | MA Course Director | Novelist | Editor
Julia Bell is the author of three novels – Massive (Macmillan, 2002), Dirty Work (Macmillan, 2007), The Dark Light (Macmillan, 2015). Also co-editor of the bestselling Creative Writing Coursebook (Macmillan 2001) She is the editor of several volumes of short stories, most recently The Sea in Birmingham (Tindal Street Fiction Group, 2014) She is also the founder and project co-ordinator of Birkbeck’s annual literary magazine, The Mechanics’ Institute Review. Her work reflects an interest in feminist readings of culture, the problems and paradoxes of British regional identity, and the need to invigorate and champion independent publishing in an age of globalized media.

JODIE KIM
Lecturer in Creative Writing | Novelist | Editor
Jodie Kim holds a PhD in Creative Writing and Contemporary Literature from the University of Manchester where she was the recipient of the Centre for New Writing Fellowship and the Widening Participation Fellowship. Her critical and creative work focus on the intersection of racial, gendered, and political violence and literature. She worked as an editor for The Manchester Review and is a co-founder of Hex Press, which aims to produce and promote feminist and queer experimental literature and art. She is working on her first novel about an ice cream store built after the American Civil War.

KATHERINE ANGEL
Lecturer in Creative Writing
Katherine Angel is a writer of literary non-fiction. Unmastered: A Book On Desire, Most Difficult To Tell was published in the UK in 2012 by Penguin and in the USA by Farrar, Straus & Giroux. It was also translated into several European languages. Her research and writing focus on contemporary and historical questions relating to sexuality, gender, and feminism. She has written for publications including The Independent, Prospect, The New Statesman, Aeon, The Los Angeles Review of Books, and Five Dials, and she reviews for the Times Literary Supplement and Poetry Review. Katherine studied at Cambridge and Harvard universities, and has a PhD in the History and Philosophy of Science from the University of Cambridge. She has held fellowships and has taught at both undergraduate and postgraduate levels at the University of Warwick, at Queen Mary, University of London, and at Kingston
University. Her research has been published in journals including History of the Human Sciences, Studies in Gender and Sexuality, Biosocieties, and The Lancet. She is completing a book on consent, desire, and arousal, and speaks regularly about her work and with other writers at universities, cultural institutes, and art venues. She also collaborates on live art readings of her work with performance group The Blackburn Company.

JONATHAN KEMP
Lecturer in Creative Writing
Jonathan Kemp’s first novel, London Triptych (2010), was shortlisted for the inaugural Green Carnation Prize and won the Authors’ Club Best First Novel Award. His highly praised collection of short stories, Twentysix (2011), is a milestone of literary erotica in the tradition of Georges Bataille and Jean Genet. His second novel, Ghosting was published to widespread critical acclaim in 2015. His fiction and non-fiction has appeared in Chroma, the online queer literary journal Polari, Brand Magazine, and in the anthologies Best Gay Erotica 2010 and Best Gay Short Stories 2010.

MARINA WARNER
Professor of English and Creative Writing
Marina Warner is a contributing editor to The London Review of Books, a Fellow of the British Academy, a Quondam Fellow of All Souls College, Oxford, and, since 2017, President of the Royal Society of Literature. She was made DBE in 2015, and the same year was awarded the Holberg Prize in the Arts and Humanities. She chaired the Man Booker International Prize for 2015. Her third collection of short stories, Fly Away Home, was published by Salt in autumn 2015.

LUKE WILLIAMS
BACW Tutor | Lecturer in Creative Writing | Novelist | Non-fiction writer
Luke Williams won the Saltire Prize for his first novel The Echo Chamber (2011) and he is currently working on a second book that tells the story of the island of Diego Garcia. Luke’s writing is research-based and seeks, via collaborative practice and the use of selected constraints, to close the formal gap between history and story. His work is informed by studies in History at Edinburgh University and Creative Writing at UEA. He co-organises the occasional live literature night, Plum.
## Contact Details

### Academic Contacts

<table>
<thead>
<tr>
<th>Name</th>
<th>Email</th>
<th>Address</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toby Litt</td>
<td><a href="mailto:t.litt@bbk.ac.uk">t.litt@bbk.ac.uk</a></td>
<td>310, 43 Gordon Sq</td>
<td>020 3073 8210</td>
</tr>
<tr>
<td>Julia Bell</td>
<td><a href="mailto:jh.bell@bbk.ac.uk">jh.bell@bbk.ac.uk</a></td>
<td>205, 43 Gordon Sq</td>
<td>020 3073 8217</td>
</tr>
</tbody>
</table>

### Administrative Contacts

<table>
<thead>
<tr>
<th>Name</th>
<th>Email</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amy Flaye</td>
<td>MA Creative Writing</td>
<td>MA Renaissance Studies, MA Medieval Literature and Culture, MFA Creative Writing, MA Creative &amp; Critical Writing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Room G19, 43 Gordon Square</td>
</tr>
<tr>
<td>Esther Ranson</td>
<td>BA English, BA Arts &amp; Humanities</td>
<td>0203 073 8378 <a href="mailto:e.ranson@bbk.ac.uk">e.ranson@bbk.ac.uk</a></td>
</tr>
<tr>
<td>Annmarie Shadie</td>
<td>BA Creative Writing</td>
<td>0203 073 8379 <a href="mailto:a.shadie@bbk.ac.uk">a.shadie@bbk.ac.uk</a></td>
</tr>
<tr>
<td>Anthony Shepherd</td>
<td>MPhil/PhD programme</td>
<td>0203 073 8374 <a href="mailto:ajshepherd@bbk.ac.uk">ajshepherd@bbk.ac.uk</a></td>
</tr>
<tr>
<td>Sarah Walker</td>
<td>MA Cultural &amp; Critical Studies, MA Modern &amp; Contemporary Literature, MA Victorian Studies, MA Contemporary Literature and Culture</td>
<td>0203 073 8381 <a href="mailto:sc.walker@bbk.ac.uk">sc.walker@bbk.ac.uk</a></td>
</tr>
<tr>
<td>Isobel Alexis</td>
<td>BA Theatre and Drama Studies, BA Theatre and English, MFA Theatre Directing, MA Text and Performance</td>
<td>0203 073 8381 <a href="mailto:i.alexis@bbk.ac.uk">i.alexis@bbk.ac.uk</a></td>
</tr>
</tbody>
</table>
Appendix A: Term Dates and Deadlines

<table>
<thead>
<tr>
<th>Autumn Term</th>
<th>Spring Term</th>
<th>Summer Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday 1 October to Friday 14 December 2018</td>
<td>Monday 9 January 2017 to Friday 24 March 2017</td>
<td>Monday 24 April 2017 to Friday 7 July 2017</td>
</tr>
<tr>
<td>Week 1 1-Oct-18</td>
<td>Week 1 14-Jan-19</td>
<td>Week 1 29-Apr-19</td>
</tr>
<tr>
<td>Week 2 8-Oct-18</td>
<td>Week 2 21-Jan-19</td>
<td>Week 2 6-May-19</td>
</tr>
<tr>
<td>Week 3 15-Oct-18</td>
<td>Week 3 28-Jan-19</td>
<td>Week 3 13-May-19</td>
</tr>
<tr>
<td>Week 4 22-Oct-18</td>
<td>Week 4 4-Feb-19</td>
<td>Week 4 20-May-19</td>
</tr>
<tr>
<td>Week 5 29-Oct-18</td>
<td>Week 5 11-Feb-19</td>
<td>Week 5 27-May-19</td>
</tr>
<tr>
<td>Week 6 5-Nov-18</td>
<td>Week 6 18-Feb-19</td>
<td>Week 6 3-Jun-19</td>
</tr>
<tr>
<td>Week 7 12-Nov-18</td>
<td>Week 7 25-Feb-19</td>
<td>Week 7 10-Jun-19</td>
</tr>
<tr>
<td>Week 8 19-Nov-18</td>
<td>Week 8 4-Mar-19</td>
<td>Week 8 17-Jun-19</td>
</tr>
<tr>
<td>Week 9 26-Nov-18</td>
<td>Week 9 11-Mar-19</td>
<td>Week 9 24-Jun-19</td>
</tr>
<tr>
<td>Week 10 3-Dec-18</td>
<td>Week 10 18-Mar-19</td>
<td>Week 10 1-Jul-19</td>
</tr>
<tr>
<td>Week 11 10-Dec-18</td>
<td>Week 11 25-Mar-19</td>
<td>Week 11 8-Jul-19</td>
</tr>
</tbody>
</table>

Most services will be unavailable from 5pm on Friday 20 December 2018, re-opening at 9am on Wednesday 2 January 2019.

Most services will be unavailable from Thursday 18 April to Wednesday 23 April inclusive. Normal services will resume from 9am on Monday, 24 April 2019.

Most services will be unavailable on Monday 6 May & Monday 27 May 2019.

---

### Autumn Term

- **Induction for all new MFA Students**: Thursday 27 September 2018
- **Launch Party for Mechanics’ Institute Review**: Thursday 25 September 2018
- **Advanced Writing Workshop begins**: Tuesday 2 October 2018
- **Reading week no classes**: Week beginning 5 November 2018

### Spring Term

- **Deadline for coursework**: Monday 14 January 2019
- **Reading and Writing the Contemporary begins**: Wednesday 16 January 2019
- **Reading week no classes**: Week beginning 18 February 2019

### Summer Term

- **Deadline for coursework**: Monday 29 April 2019

### Dissertation Deadline

- **Monday 9 September 2019, 2pm via Turnitin**
Appendix B: How to Format Your Fiction
by Benjamin Wood

This document is intended to give you, the creative writing student, a general template you can refer to in order to correctly format your fiction for your assignments. It represents the standard expectations of publishers, agents, and literary journals for manuscript submissions. As you can see, the prose is double-spaced; in Microsoft Word, you do this by going to Format > Paragraph > Line Spacing > Double. This makes the prose easy to read, and gives your lecturer/editor ample space to write interstitial comments.

It is also typewritten in a sensible font (Gill Sans – though Times New Roman, Arial, Verdana, or Garamond are other good, sensible fonts) and in a sensible font size (11pt or 12pt). Further, there are ample margins of 2.5cm (Left), 2.5cm (Right), 2.5cm (Top) and 2.5cm (Bottom). You can alter the margins in Microsoft Word by going to Format > Document > Margins. The text can be justified or simply left-aligned. Pages should always be printed single-sided.

“Dialogue is indented like this,” one person said.

“And the first line of long passages of dialogue such as this, which are so long that they take up another line, are indented too,” someone replied.

In fact, every first line of every new paragraph is indented in this way. You can set up Microsoft Word to do this automatically by going to Format > Paragraph > Special > First Line.

When you want to indicate a large break in narrative time between scenes, you do so by leaving two paragraph spaces and left-aligning the prose, like this. (You should only
do this when there are significant gaps in narrative time you want to imply to the reader; never do this between paragraphs of continuous action in the same scene.)

When you move onto the next paragraph, the first line should be indented again, like this. Make sure that you don’t leave additional spaces between your paragraphs by adjusting your settings in MS Word. Go to: Format > Paragraph > Spacing and check the tick-box beside “Don’t add space between paragraphs of the same style”, or “Remove Space After Paragraph”.

It seems like this sort of thing is not very important but, in fact, it is. Correct formatting creates the impression of professionalism, indicating to agents and editors that you are a writer who knows what you are doing.

Other things to note: your pages should be numbered (ideally in the bottom right-hand corner of every page). You do this in Microsoft Word by going to Insert > Page Numbers. And you should include a word count at the end of your manuscript. You can find out what your word count is by going to Tools > Word Count.

Happy writing!

(448 words)
Appendix C: Extracurricular Opportunities

The Mechanics’ Institute Review is an annual magazine of short fiction by Birkbeck Creative Writing students, and MACW Alumni. A call for submissions is sent out annually in December and students can volunteer to form an editorial team who will be responsible for selecting the material to be published. The aim of the magazine is to showcase the best new fiction by Birkbeck writers, with a distribution beyond the university to literary agents, publishers, etc. Students will be expected to make decisions on format, content, design, and production, as well as oversee the physical manufacture and launch of the magazine. Although students who volunteer will not be eligible to submit work to that year’s issue of MIR, they will be able to submit in subsequent years. Students are encouraged to visit London Bookfair in April (free to students). A call for volunteers will go out in November.
Appendix D: Getting Started with Moodle

Logging in and getting started

All modules within the School of Arts use Moodle (a Virtual Learning Environment, or VLE) for circulating module information and coursework submission.

- To log in to Moodle you will need your ITS username and password, a computer with a connection to the internet and a web browser such as Internet Explorer or Firefox.

- If you are having login problems, but your password is working for other services, please change your password via the online form at http://www.bbk.ac.uk/its/password (allow one hour after completing this form, and then log in again). If this hasn't resolved the problem please contact the ITS Helpdesk via email (its@bbk.ac.uk), telephone (020 7631 6543), or in person (Malet St building, next to the entrance to the Library).

- There is support information available in Moodle if you click on the Support menu and select ‘Moodle Support for Students’.

Contact ITS: You can contact the ITS Helpdesk via email (its@bbk.ac.uk), telephone (020 7631 6543), or in person (Malet St building, next to the entrance to the Library).
Appendix E: Campus Map

www.bbk.ac.uk/maps